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Disclaimer 
Whilst every care has been taken in the preparation and publication of this document, errors in content, 
typographical or otherwise, may occur. If you have queries regarding its accuracy please contact RSI at the 
address shown on the title page. 
 
With a policy of continual improvement RSI reserves the right to alter specification without notice. 
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1 Overview 
 

1.1 What is Aries? 
 
The Aries system is a TETRA network survey tool that provides network performance statistics. It comes in 
the following configuration options: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 1: Aries Configurations Options 

 

This document covers options 1 and 2 above using the Aries Windows Software.  

1) Aries Windows Software standalone 

             

2) Aries Windows Software for logging with web browser access to Aries Server for analysis 

                                 

3) Aries Probe for autonomous logging with web browser access to Aries Server for analysis, 
‘Aries probe Controller’ Android App for probe control and indoor positioning 

                                                                                   

                                            
                                                                                                   

4) Voice Quality and SDS testing using a 2nd fixed transponder probe 

                                                                                  

                                            

                                                                                                                              

http://192.168.1.2/
http://192.168.1.2/
http://192.168.1.2/
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1.2 Aries Windows Software 
 
Aries Windows Software offers a Windows software based alternative to the Aries probe providing much of 
the same functionality as the probes (with the exception of VQ & SDS testing). The following table 
summarises the main functionality differences: 
 

 1) Aries 
Windows 
Software 

standalone 

2) Aries 
Windows 

Software with 
Aries server 

3) Aries Probe 
with server 

4) Aries Probe 
with server & 
transponder 

probe 

 Motorola 
SCOUT Software 
(now obsolete) 

Log TETRA data from Motorola 
terminal in PEI mode 

    
  

Log TETRA data from Motorola 
terminal in Airtracer mode 

    
 

 

Log TETRA data from 
Sepura terminal 

    
  

Log TETRA data from Teltronic 
terminal 

    
  

Log DMR Tier 3 data from Tait 
terminal 

  
  

  

Unattended autonomous 
logging of data 

  
  

  

Android App for indoor survey 
positioning 

  
  

  

Suitable for limited survey of 
small area 

    
 

 

Suitable for large scale survey 
of complete network 

 
   

  

Suitable for contractual 
network performance testing 

 
   

  

Decoding key Layer 2/3 
parameters (Motorola only) 

    
 

 

Layer 2/3 PDU decode 
  

   
 

View data in table 
    

 
 

View data on graph 
    

 
 

Save & replay data in local files 
  

   
 

Single database for all data 
from multiple probes 

 
   

  

Display results on maps 
    

 
 

Square km analysis with 
management level reporting 

 
   

  

KPI analysis  
   

  

Neighbour Analysis  
   

  

Voice Quality testing    
 

  

SDS testing     
 

  

Export results to kmz file 
    

 
 

Group Call Generator 
    

 
 

Advanced analysis by 
date/probe/area/base 
site/custom filter 
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Real-time monitoring of large 
operational networks 

 
   

  

Email/SMS warnings for 
exception conditions 

 
   

  

Packet Data Testing  
  

  

Indoor location floor plans 
    

 
 

 
 
Aries Windows software can be used in standalone mode or with the Aries server for more advanced analysis 
and mapping functionality. 
 
 

1.3 Installation and Licensing 
 
The latest version of the Aries software can be downloaded from this page: 
http://www.rsi-uk.com/aries-windows-software/ 
 
Once installed, Aries Windows checks for a new version each time it is started and gives the user the option 
to download and install the new version. We recommend always downloading and installing to ensure you 
are running the latest version. 
 
This software requires a USB License Dongle to work – contact RSI to purchase one. 
 
A GPS receiver such as BU-353s4 providing NMEA messages at 4800 baud is required for surveys. 
 
A suitable RS232 cable to connect to the TETRA radio terminal is required for surveys: 
 

TETRA Terminal Cable 

Motorola MTM 700/800/800e GMKN1022A 

Motorola MTP 800 Series/CEP400 PMKN4025A 

Motorola MTP 810Ex/MTP 850Ex PMLN5237A 

Motorola MTP35xx, MTP66xx, MXP600 PMKN4127 (RS232) 

Motorola MTP85xx PMKN4159 (RS232) 

Motorola MTM5xxx, MTM8xxx PMKN4104 (RS232) 

  

Sepura SRG 300-00437 (USB) , 300-00065 (RS232) 

  

Teltronic MDT-400 D02605 

  
Note that when using an RS232 cable, an RS232 to USB adapter will be required as well. It is recommended 
to use adapters that use the FTDI chipset – some older adapters that use the Prolific chipset can have 
problems on Windows 11. 
 
 

  

http://www.rsi-uk.com/aries-windows-software/
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2.0 User Interface 
 
Aries Windows uses a multi window user interface as shown below: 
 

 
Figure 2: Aries Windows main screen view 
 
Individual windows may be enabled or disabled from the ‘View’ menu. Click the ‘x’ in the top right of a window 
to close it. 
 
Windows can either be docked or floating. Click the ‘▼’ in the top right of a window to select whether the 
window is Floating, Docked or a Tabbed Document. 
 
To move a window, click and hold the title bar while moving it to another window. To dock the window next 
to the second window, move the first window, while still holding the mouse down, onto one of the square 
direction indicators as shown:  

 
This determines whether the first window appears to the top, bottom, left or right or as a tab to the second 
window. 
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2.1 Operating Modes 
 
Aries Windows operates in one of the following modes: 
 
IDLE:   GPS & Radio ports closed, no file selected, no data in memory 
VIEW FILE:  GPS & Radio ports closed, file(s) selected and held in memory to be viewed 
MONITOR:  GPS & Radio ports open & communicating, viewing last 60 mins of real-time data 
LOG TO FILE:  GPS & Radio ports open & communicating, saving real-time data to file(s) 
LOG TO SERVER: GPS & Radio ports open & communicating, sending real-time data to server 
 
 
Aries Windows starts up in IDLE mode. 

If this is the first time running Aries Windows, click the  button and specify the GPS and Radio Com 
Ports on the Settings form. 
 

To VIEW an existing File or files, click the  button or menu option 
 

To enter MONITOR mode, click the  button or menu option. To return to IDLE mode, click the button 
again. 
 

To LOG TO FILE real-time data, click the  button while in MONITOR mode 
 

To LOG TO SERVER real-time data, click the  button while in MONITOR mode 
 

To stop the logging to file or server, click the  button and return to MONITOR mode 
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2.2 Configuration 
 

2.2.1 Radio and GPS 
Before starting a survey the com ports must be specified for the TETRA radio terminal and GPS device if 
used.  
 
The options for the TETRA radio are: Motorola, Sepura or Teltronic. If using a Motorola radio terminal then 
it may be used with the radio either in PEI mode giving basic information, or in Airtracer mode giving full 
Layer 2/3 information. This is set from the radio terminal front panel. 
 
The options for GPS are: External device such as BU-353s4 that connects to the PC USB socket usually at 
4800 Baud, Internal GPS in the TETRA radio terminal – this normally needs to be enabled from the radio 
terminal front panel, or Manual Positioning which is usually used for indoor or underground surveys where 
GPS signals are not available. The Manual Positioning option allows the user to click on a floor plan or 
map to indicate the current position during the survey. 
 
The Interpolation option is available for all types of positioning and enables the generation of coordinates 
when GPS is temporarily lost. The algorithm takes the last known valid coordinate and the first valid 
coordinate after GPS loss and spreads any samples taken equally along a straight line between the two 
coordinates. The algorithm works best when the GPS is lost for only short periods, e.g. when going 
through a tunnel. 
 

 
Figure 3: Configuration Form – Radio and GPS 
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2.2.2 Events 
 
This form is used to specify the rate that log events are generated in Aries. The fastest rate is every 1 sec. 
 
See section 2.9 for an explanation of the Call Generator settings. 
 
The Timestamps options specifies whether timestamps are in UTC or the PC local time. 
 

 
Figure 4: Configuration Form – Events 
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2.3 Open File 
 
Selecting an .atp file (Airtracer logged from Motorola terminal in Airtracer mode) or .log file (Aries Events 
logged from all other terminals) shall load all data into memory and display the data on the Data Logs table 
and graph as well as the Call Generator form if calls were made during the logging. 
 
If an atp file is selected then the Aries Events are created and displayed on the form when the file is 
loaded. Monitor events are created at the rate specified on the Events tab of the Settings form. 
 
Multiple files may be selected from the File Selection form using the standard shift/ctrl + click method.  
 
Data is displayed in the Data Log window in separate lists as Airtracer events and Aries events. Airtracer 
events are only display if an atp file has been selected. If a .log file has been selected then only Aries events 
are displayed. 
 

 
Figure 5: Airtracer Layer 2/3 data 
 

 
Figure 6: Aries Events 
 
The Airtracer and Aries events lists plus the Graph and Call Generator list are synchronised so clicking on 
an event in one list highlights the corresponding event in the other list as well as moving the cursor on the 
graph to the corresponding point. 
 
CS/HS/DL values in the Aries events list show the time in milliseconds for the Call Setup Time or Handover 
time or Download time depending on the event type. 
 
To delete events from the Aries Events list, select one or more events and then right-click to bring up the 
menu. Select ‘Delete Events’. The selected events will then disappear from the list and will also not appear 
in any exported files. Note that the events are not deleted from the file and will reappear the next time the 
file is read and viewed. 
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Double-clicking on an Airtracer event displays the decoded PDU information in the pop-up window: 
 

 
Figure 7: Aries Windows PDU decode form 
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2.4 Log to File 
 
While in Monitor mode, clicking the ‘Log to File’ button will start logging the received data to the specified 
filename. To avoid recording massive files that can be hard to view and analyse, the logging process limits 
the maximum file size based on either time per file or messages per file as specified on the ‘Files Options’ 
tab on the Settings form. 
 

 
Figure 8: Aries Windows Log to File settings 
 
Multiple log files are named in the format:  filename_000x.atp with x incrementing for each additional file. All 
files are saved into the same folder. 
 
To stop logging to file, click the ‘Stop’ button 
 
If the radio terminal is in Airtracer mode then data may be saved either as an .atp file containing all of the 
Layer 2/3 details or as a .log file containing Aries Events. 
 
If the radio terminal is in PEI mode then the data may only be saved as a .log file. 
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2.5 Log to Server 
 
While in Monitor mode, clicking the ‘Log to Server’ button will start logging the received data to the specified 
Aries server. 
 
An Aries Probe must have already been setup and configured on the Aries server with the same IMEI as 
specified on the Server tab of the Settings form. Normally the IMEI is used to uniquely identify an Aries 
probe and cannot be changed – however when using Aries Windows software any random number may be 
used as the IMEI as long as it matches the IMEI on the server. 
 
The server URL must be specified, e.g. https://rsi-aries.com 
 

 
Figure 9: Aries Windows Log to Server settings 
 
Events are logged to the Aries server in real-time as they are produced by the radio terminal. In the event 
that the Internet connection is lost during logging, the accumulated data shall be held in memory and 
periodically saved to a temporary file. 
 
To stop logging to server, click the ‘Stop’ button 
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2.6 Graph 
The signal level received from each base site is shown as a separate line on the graph. The current serving 
cell is displayed with a thicker line, the neighbour cells are in thinner lines. In addition the MER, RDC and Tx 
Power values are shown as a % using the right-hand Y-axis scale. 
 

 
Figure 10: Graph window 

 
The signal level values for each line are displayed on the cursor line. Clicking on the graph synchronises all 
other windows to the same point in the data. Left and Right buttons can be used to step through the data. 
The X-Axis scale may be zoomed in and out using the mouse wheel. 
 
Right-clicking on the graph displays a pop-up menu with configuration options plus an option to save the 
graph as an image. The image format is selectable on the ‘save as’ dialog form from PNG, JPG, GIF, BMP, 
SVG and PDF. 

  
Figure 11: Graph right-click pop-up menu 
 
The graph configuration settings form can be selected from the right-click menu or the main menu: 
 

 
Figure 12: Graph settings 
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2.7 Maps 
 

2.7.1 OpenStreetMap 
Survey data may be displayed as maps in the Aries map window using map images from OpenStreetMap 
as the background when the PC is connected to the Internet. The map images may still be available even if 
the PC is disconnected from the Internet if they have previously been viewed and remain in the cache.  
 
The ‘OpenStreetMap’ layer must be ticked in the ‘Mapping’ tab on the Settings form for map images to be 
visible. 
 

 
Figure 13: Map window 
 
Click the ‘+’ and ‘-‘ buttons to zoom in and out, or click the right-click menu, or use the mouse scroll wheel. 
To Pan the map, click on a point and drag the mouse across the map. The map image may be saved to a 
file or copied to clipboard from the right-click menu. 
 
The map is synchronised with the graph, and Airtracer and Event windows so that clicking on an icon on the 
map will cause these other windows to highlight the same selected data point. On the map the selected data 
icon pans to the central cross-hairs  on the map window. 
 
To configure the icon colour thresholds, select the Settings button , or select ‘Settings’ from the right-click 
menu. Click the ‘Colour Thresholds’ button on the Mapping tab. 
 

 
Figure 14: Set Colour Threshold for the map 
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Select the appropriate option for colouring the icons: RSSI [dBm], C [dB], MER [%] or Base Site and tick the 
colour bands that are required. If Base Sites are selected then the colours will come from the Base Site 
Database if the site is already listed, or will just be a random colour if it is not in the database. 
 
 
 

2.7.2 Map Overlays 
Aries can display overlay map images on top of the OpenStreetMap images. These can be wide area maps 
or building floor plans for indoor surveys. The software allows the user to import and geo-reference these 
images so that they are positioned correctly on the map and are aligned to the correct coordinates. It is 
possible to import map images from the Aries server which have already be geo-referenced, or to import 
images directly into the Aries Windows Software and to carry out the geo-referencing in the software. This 
is all configured from the Mapping tab on the Settings form as shown below: 
 

 
Figure 15: Map Overlay list 
 
This form lists all of the available overlay images. One or more overlays may be selected for viewing on the 
map by selecting the tickbox for that overlay. Clicking on an overlay in the list will pan the map window to 
that overlay. If the ‘Display overlays in original projection’ option is selected then the overlay is displayed 
without the OpenStreetMap background and in the original image orientation, however the coordinates it 
produces are still correct. This option may be useful for indoor surveys using floor plans where it is not 
important to have the image aligned to the North. 
 
Overlay images may be imported directly into the Aries Windows Software by clicking the ‘Add Overlay 
Manually’ button. This displays the form below: 

 
Figure 16: Geo-reference an image 
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Follow these steps to import and geo-reference an image: 
1) Click the ‘…’ button to Select an image file. The file format may be png, .jpg, .bmp, .svg . 
 
2) Click the ‘Point 1’ option select and click on a control point on the imported image (left side of the form). 
Either enter the Latitude and Logitude coordinates for this control point if you already know them, or click on 
the corresponding point on the OpenStreetMap (right side of the form), zooming and panning as necessary. 
 
3) Repeat the previous point for Point 2 and Point 3. Selecting reference points that are widely spread over 
the overlay image, rather than bunched together, will greatly improve the accuracy of the geo-referencing. 
 
4) When you have 3 reference points correctly selected then click the ‘Test’ button to display the geo-
referenced image on top of the OpenStreetMap image on the right side. If you are happy that the overlay is 
correctly geo-referenced then enter a name for it and click the ‘Save’ button. 
 
5) The geo-referenced overlay will now appear in the list of overlays on the Settings form under the ‘Local’ 
heading and can be selected using the tick box to be displayed on the main map.  
 
Overlay images may also be imported from the Aries server if you have access to one by clicking the ‘Add 
an Aries Server as overlays source’. This displays the form below: 
 

 
Figure 17: Get Overlays from Aries Server 
 
Enter the URL, username and password for the Aries server and click the ‘Get/Update Overlay List’ – it may 
take a few seconds to get the list from the Aries server. 
 
Click ‘Download’ for each overlay that you will need to use on the PC – this overlay will then appear on the 
main list on the Settings | Mapping tab under the server name heading and can be selected as before to be 
displayed on the map. 
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2.8 Export Data 
 

2.8.1 Export to File 
This Option is selected from the File menu. Data must first be open and visible in Aries, either by opening 
an .atp or .log file or from logging live data while in Monitor Mode or Logging Mode. 
 
Data may be exported to the following file formats: 
 
- kmz for viewing in Google Earth showing a map of coverage. The parameters available to colour the event 
icons are RSSI, C1, MER and Serving Base Site (LAC) 
 
- csv file containing the Aries Events for further analysis in Excel in the following formats: 
 - Aries Tabular, this is a general format similar to the format exported from Aries Server 
 - TRACES Data Import 
 - TRACES Base Station Summary 
 
- csv file containing the Call Generator data 
 
- log file containing the Aries Events for reading in Aries Windows or import to the Aries Server 
 
 

   
Figure 18: Export to File for csv and kmz files 
 
For kmz file export, select the colour thresholds required by ticking the checkboxes for each colour and then 
setting the threshold value accordingly. In addition it is possible to select whether the kmz export file includes 
Altitude values, Base Site icons and Base Site-to-event lines showing the serving site – click the tick boxes 
accordingly. 
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Exported kmz files may be viewed in Google Earth or other software as shown below. Clicking on events 
displays a pop-up box with details of the event. 
 

 
Figure 19: Aries kmz file with events coloured by RSSI 
 
 

 
Figure 20: Aries kmz file with events coloured by TETRA Serving Base Site (LAC) 
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2.8.2 Export to Server 
This Option is selected from the File menu. Data must first be open and visible in Aries, either by opening 
an .atp or .log file or from logging live data while in Monitor Mode or Logging Mode. 
 
Data may be exported to the Aries server specified in the Settings form using the form shown below: 
 
 

 
Figure 21: Aries Windows Export to Server 
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2.9 Call Generator 
 
In Monitor Mode, Log to File or Log to Server Modes, it is possible to use the Call Generator form to produce 
regular test calls on the current selected Talk Group. The Call Generator is initiated and stopped by clicking 
the Start/Stop button. 
 

 
Figure 22: Call Generator 
 
The form shows totals for Successful, Failed and No Service call events. The Call generator results may be 
exported to a text file for further analysis from the ‘Export Data’ form. 
 
The test call duration and interval are set from the ‘Events’ tab on the Settings form – see section 2.2.2: 
‘Initiate Call’ is the time in secs between successive test calls 
‘Call’ is the time in secs that the call is held before it is disconnected 
‘Group Call’ is the GSSI of the Group to be used for the test call. This should always be a Group that is not 
in use by other users. 
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2.10 Indoor Positioning 
Carrying out an indoor or underground survey will usually mean that GPS will not work so it will not be 
possible to track the survey location. Aries allows the user to set location manually by clicking on the current 
location during a survey – this works best for walking surveys with hand-held equipment where the speed is 
just a few km/h. 
 
1) Select Configure | Settings | Radio and GPs tab | Use Manual Positioning 
 
2) Click the ‘Connect’ button to start communications with the TETRA radio terminal 
 
2) Move the map so that the central cross-hairs  are on the start position, and click the cross-hairs so that 
the location is marked with a green circle O 
 
3) Click the ‘Log To File’ or ‘Log to Server’ buttons as appropriate to start the survey 
 
4) Start moving in the survey area and as a known location is reached, move the map again so that the new 
location is under the cross-hairs, and then click the cross-hairs to fix that location. 
 
5) Keep moving at a steady speed, setting new locations around every 10secs or so. The best technique is 
to move in straight lines and click whenever changing direction. As new locations are fixed, a straight red 
line is drawn between each point indicating the route taken. When the next sample is logged, the samples 
logged since the previous location fix are then displayed equally spaced along the red line. 
 
6) At the end of the survey, click on the final location and then click the ‘Stop’ button. 
 

 
Figure 23: Indoor Positioning 
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2.11 Base Site Database 
Aries includes a base sites database. This helps with analysis by associating a name with a LAC and also 
includes coordinates for displaying an icon on the map. 
 

 
Figure 24: Base Sites Database 
 
Right-clicking on the form displays the following pop-up menu: 

 
Figure 25: Base Sites Database right-click pop-up menu 
 
Selecting ‘Edit Base Site’ or ‘Add Base Site’ displays the following form allowing the base site details to be 
entered for a single site. 

 
Figure 26: Add / Edit Base Site details 
 



Aries Reference Manual  Aries Windows Software 

Radio Systems Information  Page 25 

Selecting ‘Import Base Sites (csv)’ or ‘Export Base Sites (csv)’ allows the user to import or export the base 
sites data to a csv file in the following format: Single Header line followed by 1 line per base site with all fields 
separated by a comma ‘,’ as shown below: 
 
Header: 
Name,LAC,Lat,Lon,Reference,Details,Colour,Beamwidth,Direction,Planned Frequencies,Used 
Frequencies,Planned Neighbour Cell List,Neighbour Cell List,FRT,SRT,FRH,SRH,Min Rx,Max Tx,Acc 
Par,Col,Sub,Sec,MCC,MNC,Enc,BS,Additional Information 
 
Example data: 
Abqaiq Alt,5037,25.94489,49.67677,,,#FF4141,360,0,,420.30000,,5011:426.62500 5013:426.57500 
5021:423.77500 5022:422.20000 5031:420.17500 5032:425.42500 5041:423.00000,-1,-1,-1,-1,-1,-1,-1,-1,-
1,1,-1,-1,0,D67,BS service     Registration: 1     De-registration: 1     Priority Cell: 0     Minimum mode: 1     
Migration: 0     System Wide Service: 1     TETRA Voice Service: 1     Circuit mode data Service: 0     
SNDCP Service: 1     AI Encryption Service: 1     Advanced Link Supported: 1      Security Information     
Current cell is operating in Security Class 3 (DCK/CCK)      SDS-TL addressing     Never use SDS-TL 
Service centre addressing    
 
 
The number of fields that are included is optional but the minimum required fields are: Name, LAC and 
Colour. Lat, Lon, Reference and Details may be left blank but must have the separating commas. Fields 
after Colour may be included as required and the number of fields in the Header must match the number of 
fields in the Data lines. 
 
The format of the Planned Frequencies and Used Frequencies fields is to specify multiple frequencies using 
a space separator e.g.  
421.00000 422.37500 423.77500 423.95000 
 
The format of the Planned Neighbour Cell List and Neighbour Cell List fields is to specify multiple neighbour 
sites using the format <LAC1>:<Frequency1> <LAC2:<Frequency2> e.g. 
5012:420.42500 5013:426.57500 5014:420.05000 5016:421.00000  


